
Integritest® 4N Integrity Test Instrument 
Central Instrument Management Tool

Installation and Operators Manual



  2



  3  

Contents

Preface .............................................................................................................. 5
About this Manual .................................................................................................................5

Chapter 1 Software Installation ......................................................................... 7
Domain Mode Network Confi guration ..............................................................................7
Evaluating Network Infrastructure .....................................................................................7

Domain Requirements ................................................................................................... 7
 Report Transfer and Remote Backup ..........................................................................8
Integrated, Partially Integrated, and Isolated Networks ..................................................8
Installing the Central IMT Software on a Network Domain ..........................................9

Confi guration A: Setting up the Central IMT on One Computer  ....................... 10
Confi guration B: Setting up the Central IMT on Two Computers....................... 16
Confi guration C: Setting up the Central IMT on Three Computers ................... 23

Confi guring Instrument(s) for the Domain .....................................................................34
Confi guring a Central Repository and Backup Location ...............................................34
Confi rming Settings After Installation .............................................................................34

Using the Set Alternate Domain Tool ....................................................................... 34
Confi rming Path Settings ............................................................................................ 35
Using the ID Mapper Tool.......................................................................................... 36

Chapter 2 Introduction .................................................................................... 41
Introducing the Central Instrument Management Tool ................................................41
Features ..................................................................................................................................41

Chapter 3 Getting Started ................................................................................45
Overview ...............................................................................................................................45
Accessing the Central IMT .................................................................................................45
Setting the Central IMT Language ....................................................................................46
Graphical User Interface .....................................................................................................47

Menus ............................................................................................................................. 47
Lists and Tabs................................................................................................................ 49

Saving Changes .....................................................................................................................52

Chapter 4 Using the Central IMT ...................................................................53
Introduction ..........................................................................................................................53
Managing Users ....................................................................................................................53

Roles ............................................................................................................................... 54
Assigning Users to Roles ............................................................................................. 54
Removing Users from Roles ....................................................................................... 54
Assigning Users to Instruments ................................................................................. 55
Removing Users from Instruments ........................................................................... 55
Searching for Users ...................................................................................................... 55

Managing Instruments ........................................................................................................56



  4

Adding and Deleting Instruments ............................................................................. 56
Working with Instrument Groups ............................................................................. 57
Setting the Central Repository and Backup Location Paths .................................. 59
Canceling Report Transfer and Remote Backup ..................................................... 60
Selecting Report Transfer Options ............................................................................ 60
Selecting Remote Backup Options ............................................................................ 61
Selecting Electronic Signature Options..................................................................... 61

Managing Tests .....................................................................................................................63
Creating and Editing Tests .......................................................................................... 63
Assigning Tests to Instruments .................................................................................. 64

Reports ...................................................................................................................................65
Printing the Reports ..................................................................................................... 65

Appendix A Glossary of  Terms .......................................................................67

Appendix B Error Messages ........................................................................... 71

Index ................................................................................................................73



  5  

This manual contains the information needed to install and operate the Integritest 4N 
Central Instrument Management Tool (IMT) software in a network environment. It assumes 
that the software has already been installed and the network is properly confi gured.

This publication includes instructions on how to install the software for use on a network 
or domain, but it does not provide details on connecting instrument(s) to a network.  These 
instructions are provided in the Integritest 4N Integrity Test Instrument Network and Administrator 
Manual.

This document is intended as a reference for Millipore software. It is not intended as a 
reference source for the Microsoft® software Windows® operating system or any other 
software not manufactured by Millipore.

This manual also assumes a basic understanding of  the operation of  fi lter integrity testing 
instruments. Knowledge of  basic fi lter test operations, such as running a fi lter test or 
transferring a report, is recommended. These operations are described in the Integritest 4 
Automatic Filter Integrity Test Instrument XIT4S0001 and XIT4N0001 Operators Manual. 

 

 

Preface

About this Manual
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Prior to installing and confi guring the Integritest 4N Central IMT software, the network and 
domain must be confi gured to meet the requirements for the instrument(s) and software to 
operate properly in    Domain mode.  

The following sections outline the steps needed to confi gure the network and install the 
Central IMT software from the CD. These steps should be performed by a Network 
Administrator. 

For instructions on confi guring the instrument(s) for use on the domain, see Integritest 4 
Automatic Filter Integrity Test Instrument XIT4S0001 and XIT4N0001 Operators Manual..

Domain Requirements

A domain supporting instruments that will be managed via the Central IMT software must 
have the following three components. 

Domain Controller

Role Server

Service PC

Important:  The functions performed by each of  these components can be 
performed by multiple computers, or a single computer can provide all 
of  the functionality required. 

Each of  the components is explained in more detail below.

•

•

•

Chapter 1 
Software Installation

Domain Mode Network Confi guration

Evaluating Network Infrastructure
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Domain Controller

An existing corporate network will have a computer functioning as a Domain Controller. A 
Domain Controller is used to create and manage users. This provides the Central IMT and 
instrument(s) with all the required security, user ID, and password verifi cation information. 
The instrument(s) will verify this information at every connected domain login.

Important:  The Domain Controller must use a Windows Server 2003 operating 
system.

Role Server

The Role Server is a computer that stores information about instruments, instrument 
groups, and their users. The Role Server also stores test defi nitions and all confi gured 
parameters that are programmed using the Central IMT. The instrument(s) will download 
this information at every connected domain login.

It is expected that the Role Server will always be available over the network to provide 
instrument updates. If  the Central IMT cannot connect to the Role Server, the information 
downloaded at the last successful connection will be used.

Important:  The Role Server must use either the Windows XP® Professional or 
Windows 2003 Server operating system.

Service PC

At the Service PC, authorized users use the Central IMT to defi ne tests, setup instruments, 
and assign roles and instruments to users. Changes made from the Service PC update the 
Role Server, to which the Integritest 4N instrument(s) are connected. (The instrument(s) 
receive updates from the Role Server, not the Service PC.)

The Service PC needs to be connected to the network and needs to be part of  the domain. 
A single computer may function as both the Role Server and Service PC. Alternatively, the 
Central IMT software might be installed on a separate Service PC, or there may be multiple 
Service PCs that update the same Role Server. 

Important:  The Service PC must use either the Windows XP Professional or 
Windows 2003 Server operating system.

Report Transfer and Remote Backup

In addition to the above three requirements, if  an instrument is confi gured for report 
transfer or remote backup, it must also have a defi ned Central Repository or a Backup 
Location, respectively. There are no inherent requirements for these fi le locations, though 
they must be available over the network for the instrument to perform the related functions 
successfully.

Once the setup of  the network and the instrument(s) is complete, the instrument(s) should 
be connected to the domain, confi gured, and tested to verify that all setup steps were 
completed correctly..
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There are three primary network confi gurations the Central IMT will support in domain 
mode: isolated, integrated, and partially integrated networks. 

An integrated network assumes that all three components are 
installed on the same machine.

A partially integrated network assumes that two of  the required 
components are installed on one machine and the third component is 
installed on a separate machine. For example, the Domain controller 
might be installed on the first machine, with the Role Server and 
Central IMT software installed on a separate machine.

An isolated network assumes that all three components of  Central 
IMT software will be installed on separate machines.

While there are several possible ways a network can be confi gured to support the 
Central IMT installation, this guide provides sample instructions for the most common 
confi gurations.

This section provides instructions for installing the Central IMT software on to a network 
domain and confi guring the network so it will operate properly. Step-by-step procedures are 
provided for the following confi gurations:

Configuration A - Central IMT Software, Role Server, and Domain 
Controller are set up on the same machine (integrated network).

Configuration B - Central IMT Software and Role Server are set up on 
machine #1 and Domain Controller is set up on machine #2 (partially 
integrated network). 

Configuration C - All three components are set up on separate 
machines (isolated network). 

Important: The procedures described in this section provide examples of  how to 
install the Central IMT software for use on a network domain. The 
specific network and security configuration employed will depend on 
the requirements and capabilities of  the user organization. 

The steps in this chapter are required for the instrument(s) to operate securely in domain 
mode. By completing all of  the steps, the Network Administrator confi gures the domain to 
ensure that only authorized groups of  users can perform certain Central IMT functions (e.g., 
test management, user management, or instrument management). 

Once the setup of  the network and the instrument(s) is complete and the Central IMT 
software is installed, the instrument(s) should be connected to the domain, confi gured, and 
tested to verify that all setup steps were completed correctly.

•

•

•

•

•

•

Integrated, Partially Integrated, and Isolated Networks

Installing the Central IMT Software on a Network Domain
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Configuration A: Setting Up the Central IMT on One 
Computer that functions as the Domain Controller, Role Server 
and Service PC 

Use the procedure below to install the Central IMT software on a single computer that will 
function as the Domain Controller, Role Server, and Service PC. 

Important: The Domain Controller must use a Windows Server 2003 operating 
system.

1. At the machine that will function as the Domain Controller, Role Server and 
Service PC, log on as Domain Administrator.

Note: Contact your MIS department for assistance with performing steps 
as Domain Administrator.

2. Insert the Central IMT installation CD. The Main Menu screen appears.

Note: The Documentation button provides a link to user manuals and 
technical literature related to the software.
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3. Click the Install Software button. The Welcome screen appears.
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4. At the Welcome screen, click Next. The End-User License Agreement 
screen appears.

5. Review the license agreement terms then select the option I accept the 
terms in the License Agreement.

6. Click Next. The Choose Setup Type screen appears.
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7. Click the Complete button. The Ready to Install screen appears.
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8. Click Install. The required components are installed and the Finish screen 
appears.

The following takes place during installation:

The software is installed in the directory C:\Program files\Millipore\
IT4N.

The directory C:\Program Files\Millipore\IT4NMaster is shared as 
IT4NMaster.

The directory C:\IT Temp is created. This directory is required by the 
software for the storage of  log and configuration files.

ITX ID Server service is installed and started.

The following permission groups are created: 

ITXConfigI - to manage instrument configuration

ITXConfigT - to manage test definitions

ITXConfigU - to manage users and roles

ITXConnect and ITXRoleServer users are added to the Administrators 
permission group.

Current user (i.e., Administrator) is added to the permission groups.

•

•

•

•

•

○

○

○

•

•



  15  

The following user IDs are created:

User name: ITXConnect, Password ITXConnect00

User name: ITXRoleServer, Password: ITXRoleServer00

Note: These are virtual user IDs used by the software; they are not 
assigned to any group or person.

Important: During installation, the virtual group names and user IDs above are 
created automatically and are used by the software in domain mode.  
Depending on your organization’s security policy, the above IDs/
passwords may not be allowed.  If  this is the case, you can assign the 
IDs/passwords in accordance with your organization’s policy using 
the ID Mapper Tool.  (See “Using the ID Mapper Tool” for more 
information.)

The icons described in the table below are placed on the desktop. 

Icon Label Description

Integritest 4N 
Central IMT 

Used to launch the Central IMT (after 
domain mode setup is complete).

Integritest 4N 
ID Mapper 

Used to launch the Integritest 4N ID 
Mapper Tool. This utility is used to map 
user names and passwords used by the 
software to the user organization’s preferred 
passwords, if  required.

9. Click Finish to exit the installation program.

10. Double click on Integritest 4N Central IMT icon to the launch the Central 
IMT software. Verify that you can create an instrument and assign one or 
more users to the instrument.  If  you encounter problems, refer to the 
section “Confi rming Settings after Installation.”

•

○

○

•
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Configuration B: Setup Up the Central IMT on Two Computers, 
where the First Computer is a Domain Controller and the Second 
Computer will function as Role Server and Service PC

Domain Controller Confi guration

Important: The Domain Controller must use a Windows Server 2003 operating 
system.

1. At the Domain Controller computer, log on as Domain Administrator.

Note:  Contact your MIS department for assistance with performing steps 
as Domain Administrator.

2. Create the following permission groups:

ITConfigI - to manage instrument configuration

ITConfigT - to manage test definitions

ITConfigU - to manage users and roles

3. To each group, add the User IDs (Domain Users) of  the Instrument 
Administrators selected to perform the related functions (instrument 
confi guration, test defi nition, and user management).

4. Create the following users with Password never expires option set:

User: ITXConnect, Password ITXConnect00

User: ITXRoleServer, Password: ITXRoleServer00

Note: These are virtual user IDs used by the software; they are not 
assigned to any group or person.

Important: These virtual group names and user IDs are used by the software in 
default mode.  Depending on your organization’s security policy and 
password complexity requirements, the above IDs/passwords may not 
be allowed.  If  this is the case, assign the IDs/passwords in accordance 
with your organization’s policy and make a note of  the IDs/passwords 
used.  If  IDs/passwords cannot be set as above, you must use the ID 
Mapper Tool at the Role Server computer to map the IDs/passwords.  
(See “Using the ID Mapper Tool” for more information.)

•

•

•

•

•
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Role Server/Service PC 

1. At the computer that will function as the Role Server and Service PC, log on 
as an Administrator.

2. Insert the Central IMT installation CD. The Main Menu screen appears.

3. Click Install Software. The Welcome screen appears.
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4. Click Next. The End-User License Agreement screen appears.
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5. Review the license agreement terms then select the option I accept the 
terms in the License Agreement.

6. Click Next. The Choose Setup Type screen appears.

7. Click the Typical button. The Ready to Install screen appears.
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8. Click Install. The Role Server and Central IMT software is installed on the 
computer, and the Finish screen appears.
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The following takes place during installation:

The software is installed in the directory C:\Program files\Millipore\
IT4N.

The directory C:\Program Files\Millipore\IT4NMaster is shared as 
IT4NMaster.

The directory C:\IT Temp is created. This directory is required by the 
software for the storage of  log and configuration files.

ITX ID Server service is installed and started.

The icons described in the table below are placed on the desktop. 

Icon Label Description
Integritest 4N 
Central IMT 

Used to launch the Central IMT (after do-
main mode setup is complete).

Integritest 4N 
ID Mapper 

Used to launch the Integritest 4N ID Map-
per Tool. This utility is used to map user 
names and passwords used by the software 
to the user organization’s preferred pass-
words, if  required.

9. Click Finish to exit the installation program.  

10. Complete the following steps after the installation is complete:

a. If  a fi rewall (e.g., Windows Firewall) is running on the Role Server, check or 
add an exception for Integritest 4N ID Mapper on Port 23190.

b. Locate the folder C:\Program Files\Millipore\IT4NMaster, ensure its share 
name is set as IT4NMaster and do the following:

Click the Permissions button to assign ITXRoleServer and 
ITXConnect users Full Control permissions to the ITNMaster share.

Note: These are virtual user IDs used by the software; they are not 
assigned to any group or person.

At the Security tab, verify that the Administrators group has Full 
Control permissions.

c. Add users ITXRoleServer, ITXConnect, and groups ITXConfi gI, 
ITXConfi gT, and ITXConfi gU to the Administrators Group.

d. Locate the C:\IT Temp directory and verify that the Administrators group 
has Full Control sharing permissions for this directory.

e. Use ID Mapper Tool to map groups, user names, and passwords, if  needed.  
(See “Using the ID Mapper Tool” for instructions.)

•

•

•

•

•

•

•
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f. Go to Computer Management and perform the following actions:
Create three local groups: ITXConfigI, ITXConfigT, and 
ITXConfigU.

Add Instrument Administrators or each of  the global groups to 
the related local group (e.g., add ITConfigI to ITXConfigI).

g. Run the Set Alternate Domain Tool from C:\Program Files\Millipore\
IT4N. The tool will display the default settings for the Domain, Alternate 
Domain, and the Role Server as the Domain Controller PC name. Update 
the Role Server and other settings as needed. See “Using the Set Alternate 
Domain Tool” for more information.

11. Log off  as Administrator.

12. Log on as Instrument Administrator user.

13. Double click on Integritest 4N Central IMT icon to the launch the Central 
IMT. Verify that you can create an instrument and assign one or more 
users to the instrument. If  you encounter problems, refer to the section 
“Confi rming Settings after Installation.”

○

○
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Configuration C: Setting Up the Central IMT on Three 
Computers where the First is a Domain Controller, the Second will 
function as Role Server, and the Third will function as Service PC

Domain Controller

Important: The Domain Controller must use a Windows Server 2003 operating 
system.

1. At the Domain Controller computer, log on as Domain Administrator.

Note:  Contact your MIS department for assistance with performing steps 
as Domain Administrator, if  needed.

2. Create the following permission groups:

ITConfigI - to manage instrument configuration

ITConfigT - to manage test definitions

ITConfigu - to manage users and roles

3. Create the following users with Password never expires option set:

User: ITXConnect, Password ITXConnect00

User: ITXRoleServer, Password: ITXRoleServer00

Note: These are virtual user IDs used by the software; they are not 
assigned to any group or person.

Important: These virtual group names and user IDs above are used by the software 
in default mode.  Depending on your organization’s security policy and 
password complexity requirements, the above IDs/passwords may not 
be allowed.  If  this is the case, assign the IDs/passwords in accordance 
with your organization’s policy and make a note of  the IDs/passwords 
used.  If  IDs/passwords cannot be set as above, you must use the ID 
Mapper Tool at the Role Server computer to map the IDs/passwords.  
See “Using the ID Mapper Tool” for more information.

4. To each group, add the User IDs (Domain Users) of  the Instrument 
Administrators selected to perform the related functions (instrument 
confi guration, test defi nition, and user management).

•

•

•

•

•
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Role Server

1. At the computer that will function as the Role Server, insert the Central IMT 
installation CD. The Main Menu screen appears.

2. Click the Install Software button. The Welcome screen appears.
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3. Click Next. The End-User License Agreement screen appears.

4. Review the license agreement terms then select the option I accept the 
terms in the License Agreement.



  26

5. Click Next. The Choose Setup Type screen appears.
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6. Click the Custom button. The Custom Setup screen appears. 

Important:  Do not change the default installation location. The software requires 
that the files are installed in the C:\Program Files\ directory. 

7. Click the  icon next to Central IMT and select Entire Feature will 
be unavailable from the drop-down list.
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8. For the Role-Server-only installation, ensure that the custom setup window 
appears as follows.  

Note: The Standard Users and Groups option will create the local 
ITXConfi g set of  groups and add the current user to them and 
create the local ITXConnect and ITXRoleServer users with the 
standard non-complex passwords.  This should not be used if  this 
is not the desired confi guration or if  your organization requires the 
use of  more complex passwords than the defaults supplied by the 
software.  For more information, see “Using the ID Mapper Tool.”
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9. Click Next. The Ready to Install screen appears.

10. Click Install. The Role Server software is installed on the computer and the 
Finish screen appears.
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The following takes place during installation of  the Role Server:

The software is installed in the directory C:\Program files\Millipore\
IT4NMaster.

The directory C:\Program Files\Millipore\IT4NMaster is shared as 
IT4NMaster.

The directory C:\IT Temp is created. This directory is required by the 
software for the storage of  log and configuration files.

ITX ID Server service is installed and started.

The icon is placed on the desktop. This icon is used 
to launch the Integritest 4N ID Mapper Tool. This utility is used 
to map user names and passwords used by the software to the user 
organization’s preferred passwords, if  required.

11. Click Finish to exit the installation program.  

12. Go to Computer Management and add ITXConnect, ITXRoleServer 
and Instrument Administrators or the global security groups (ITConfi gI, 
ITConfi gT, ITConfi gU) to the Administrators group.

•

•

•

•

•
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Service PC

1. Complete steps 1-6 from Role Server setup procedure above.

2. Click the  icon next to the Role Server and select Entire Feature 
will be unavailable from the drop-down list.

3. For the Central-IMT-only installation, ensure that the setup options now 
appear as follows.  

4. Click Next. The Ready to Install screen appears.
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5. Click Install. The Role Server software is installed on the computer and the 
Finish screen appears.
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The following takes place during installation of  the Central IMT software onto the 
Service PC:

The software is installed in the directory C:\Program files\Millipore\.

The directory C:\IT Temp is created. This directory is required by the 
software for the storage of  log and configuration files.

ITX ID Server service is installed and started.

The icon is placed on the desktop. 

6. Click Finish to exit the installation program, and complete the following 
steps after the installation is complete.

7. Go to Computer Management and perform the following actions:

a. Add Instrument Administrators or the global security groups ITConfi gI, 
ITConfi gT, and ITConfi gU to the Administrators group.

b. Create three local groups: ITXConfi gI, ITXConfi gT, and ITXConfi gU.

c. Add Instrument Administrators or each of  the global groups to the related 
local group (ex: add ITConfi gI to ITXConfi gI).

8. Run the Set Alternate Domain Tool from C:\Program Files\Millipore\IT4N. 
The tool will display the default settings for the Domain, Alternate Domain, 
and Role Server as the current Domain Controller and Domain Controller 
PC name. Update the Role Server and other settings as needed. See “Using 
the Set Alternate Domain Tool” for more information.

9. Log out as Administrator.

10. Log in as an Instrument Administrator user.

11. Double click on the Integritest 4N Central IMT icon to launch the Central 
IMT.  Verify that you can create an instrument and assign one or more 
users to the instrument. If  you encounter problems, refer to the section 
“Confi rming Settings after Installation.”

•

•

•

•
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The procedures for confi guring an instrument on a domain are described in the 
Integritest 4 Automatic Filter Integrity Test Instrument XIT4S0001 and XIT4N0001 
Operators Manual. Please refer to this document for procedures on confi guring 
Millipore instruments for a domain.

The computer(s) upon which the Central Repository and Backup Location will reside 
must be confi gured and connected to the network.

A Network Administrator should provide sharing to the required directories on the 
computer(s) hosting the Central Repository and Backup Location. This information 
will be required in the Central IMT for Backup Location and Central Repository 
confi guration. These locations must be the same as the paths entered in the Central 
IMT (see “Central Repository and Backup Location Paths”).

Note: If  the fi les appear to go to the wrong location, consult with the 
System Administrator to verify that the Central IMT and the 
instrument(s) have been properly connected to the network.

The Central IMT software includes utilities that can be used to verify and update 
Domain, Role Server, and other settings after installation. 

Using the Set Alternate Domain Tool

The Set Alternate Domain tool is used to verify and update Domain, Alternate 
Domain, and Role Server PC settings as needed:

Set Alternate Domain Utility

To run the Set Alternate Domain utility:

Confi guring Instrument(s) for the Domain

Confi rming Settings After Installation

Confi guring a Central Repository and Backup Location
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1. Double click to open the SetAltDomain utility in the C:\Program Files\
Millipore\IT4N\ directory. 

2. Review the settings to confi rm they are correct. If  any settings are incorrect, 
update them as needed then and click Apply. Otherwise, click Cancel.

Important:  The Role Server PC field should contain the name of  the computer 
that has been configured for use as the Role Server.

Note: If  you set an Alternate Domain, the users available to the Central 
IMT will come from the Alternate Domain’s controller. 

Confirming Path Settings

Use the following steps to confi rm path settings for Default Domain, Users, Role 
Server, Role Server data, and Tests:

1. Double click the  desktop icon to start the Central IMT.

2. From the Central IMT’s Help menu, choose Paths.

 Path Settings

3. Review the settings in the Paths Window to confi rm they are correct. 

Note:  If  any settings are incorrect, you can adjust them using the Set 
Alternate Domain tool.

4 When fi nished, click OK.
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Using the ID Mapper Tool

In order for the Integritest 4N Central IMT software to operate properly in domain 
mode, the software requires—in its default confi guration—specifi c group names, 
user names, and passwords to be present on the domain. However, some of  the 
default names and passwords used by the software may not be consistent with 
network security policies, password complexity requirements, or naming standards of  
the user organization. 

The ID Mapper Tool was created so that organizations can map their required or 
preferred group names, user names, and passwords to the default group names, user 
names, and passwords used by the software.

Important: The ID Mapper Tool should be used only if  the required or preferred 
naming conventions of  the user organization are different from the 
defaults used by the software. 

Note:  If  no mappings are set, the default names will be used.

The fi gure below shows the ID Mapper Tool in default mode.

 ID Mapper Tool

Mapping Group Names, Share User Names, and Passwords

1. Log on to the Role Server computer as Domain Administrator.

2. Install the Central IMT software on to the Role Server computer, if  it was 
not installed there previously.
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3. Double click on the  icon on the Windows desktop.

Note: The tool can also be run from the C:\Program Files\Millipore\
IT4Nmaster directory.

4. Click the Edit Map button.

5. In the External Name fi elds, map the group names required or preferred by 
your organization to the Internal Names (used by the software).

Note:  Any External Name added here must exist and be properly 
confi gured on the domain in order for the mapping to be properly 
set. 
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For example:

Internal Name External Name

ITXAll MilliporeAll

ITXConfi gI MilliporeConfi gI

ITXConfi gT MilliporeConfi gT

ITXConfi gU MilliporeConfi gU

ITXService MilliporeService

ITXSupervisor MilliporeSupervisor

6. Overwrite the predefi ned user names ITXConnect and ITXRoleServer with 
the user names required or preferred by your organization.

7. Overwrite the default passwords ITXConnect00 and ITXRoleServer00 with 
the new passwords required by your organization.

Note: Passwords are visible in the ID Mapper Tool and must be preceded 
by an asterisk (*).

For example:

Predefi ned 

Name

New Name Default Password New Password

ITXConnect MilliporeConnect ITXConnect00 *MilliConnect00

ITXRoleServer MilliporeRoleServer ITXRoleServer00 *MilliRoleServer00

8. When fi nished, click OK. 

9. In the Test Mapper window, type the Internal Name as per the table in step 5 
and click Map Group. 

Test Mapper

10. Verify the mapped name is as defi ned in the External Name fi eld.

11. Close the Test Mapper.
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Chapter 2
Introduction

  Introducing the Central Instrument Management Tool
The Integritest 4N Central Instrument Management Tool (IMT) is designed to provide 
centralized administration of  filter testing instruments on a network. The Central IMT is 
used by administrators to manage instruments users, tests, reports, and other system options.

Tests administered via the Integritest 4N Central IMT can be conducted on a wide range 
of  membrane filter systems. These include on-site bubble point, diffusion, HydroCorr™ 
and additional tests. Both hydrophobic and hydrophilic membrane filters can be tested, and 
testing is not limited to Millipore products.

It is recommended that organizations install both the software and instrument(s) on 
a 21 CFR Part 11 compliant network and verify compliance after installation with the 
requirements of  21 CFR Part 11. It is the responsibility of  the end user to maintain 
compliance with this and any other data security rules and regulations.

Centralized User and Instrument Management

Centralized user and instrument management allows a user in one location to access and 
confi gure instruments in multiple locations. A test can be created at a single location and 
added to a group of  instruments without having to access each instrument individually.  
Centralized user management provides the Instrument Administrator with information 
for all of  the accounts on the domain. This allows the Instrument Administrator to assign 
users to various functions on the instrument(s) without having to create IDs or assign 
passwords. Users assigned to the instrument(s) will log in with the same name and password 
they use elsewhere on the network. Any changes made to a user account are applied to all 
instruments. For example, if  a user’s domain account is disabled by the MIS department 
because of  unauthorized access, that user will not be able to log in to any of  the Integritest 
4N instruments until the account is re-enabled. Centralized instrument management allows 
the Instrument Administrator to confi gure instruments from a Service PC. Instruments may 
be consolidated into logical groups that have the same confi gurations. For example, adding a 
test to an instrument group will add that test to all instruments within that group.

  Features
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Centralized Test Management

Test specifi cations are managed through the Test Defi nition Editor (TDE). The TDE is 
accessed via the Central IMT’s Test menu. 

New test specifi cations can be created on the Central IMT computer and added to multiple 
instruments over the network. If  this option is not used, a new test must be programmed 
on each instrument, which is more time-consuming and increases the chance of  input error. 
Central management of  the specifi cations, when used properly, ensures that all instruments 
are using the same revision of  the fi lter test.

For more information, see “Managing Tests.”

Report Transfer

Using the Central IMT, instruments can be confi gured to send completed test reports to a 
network location, hereafter called the Central Repository. The instruments send a checksum 
fi le with the report fi le that can be used to verify that the report has not been altered. 

Once the test report has been successfully transferred, the test data can be removed from the 
instrument(s) to reduce the size of  the test database.

For more information about confi guring report transfer options using the Central IMT, see 
“Selecting Report Transfer Options.” For information about report transfer options, see the 
Integritest 4N Integrity Test Instrument Network and Administrator Manual.

Electronic Signatures

Electronic signatures can be confi gured when reports are to be transferred to the Central 
Repository. A user name, time, and reason for signature are added to the report when a 
user enters the information and provides a valid password. The instruments can be set 
to require no signature, one signature, two signatures, or two signatures that include one 
provided by a Supervisor. Reports are not transferred to the Central Repository until the 
required signatures have been provided. The transferred report fi les contain the signature 
information.

See “Selecting Electronic Signature Options” for more information.

Remote Backup
Using the Central IMT, the instruments can be confi gured to back up the database 
information to a designated Backup Location on the network. Once a network location is 
set using the Central IMT, the information is automatically backed up to this location once a 
week.

For information about confi guring remote backups using the Central IMT, see “Selecting 
Remote Backup Options.” For information about remote backup options on the 
instruments, see the Integritest 4N Integrity Test Instrument Network and Administrator Manual.
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 Networking Safeguards

The Central IMT and instrument software have built-in safeguards to ensure that database 
information is not modifi ed by malicious or unintentional actions. For example, most 
operating system functions are limited to those users with a high access level.

The Central IMT can also be confi gured to comply with the technical controls of  21 
CFR Part 11 for electronic records and electronic signatures. Test reports can be signed 
electronically by the operator and a supervisor. All changes to user, test, and instrument 
confi guration are logged with the date, time, and name of  the individual making the change. 
It is the responsibility of  the end user to maintain compliance with applicable data security 
policies and regulations, including 21 CFR Part 11.
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Chapter 3
Getting Started

 Overview
When the Integritest 4N Central IMT is fi rst installed, all settings are in default mode. 

Depending on the requirements of  your organization, some of  the settings in the Central 
IMT will need to be adjusted. In addition, settings may need to be adjusted if  requirements 
within your organization change.

In most instances, you will access the Central IMT from the Service PC because you will be 
working in domain mode. 

Note:  There may be instances when you need to access the local IMT on the 
instrument. Access to the local IMT on the instrument is available only to 
users who are Instrument Administrators. 

To access the Central IMT from the Service PC:

1. Using your domain user name and password, log in to the Service PC.

2. Double-click the   desktop icon. The Central IMT (Figure 1) will 
appear.

   Accessing the Central IMT
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  Figure 1: The Central Instrument Management Tool

The default language setting for the Central IMT software is English. Do the following to 
change the language on the Central IMT:

1. Log on to the Service PC and double-click the   icon to launch 
the Central IMT.

2. Select Language from the File menu and choose the desired language.

3.  When you close the Central IMT and restart it, all of  the Central IMT strings 
will appear in the language you selected.

Important: Some of  the language strings that appear in the Central IMT originate 
from the operating system. For all text to appear in the desired language 
on the Service PC, both the Central IMT and the operating system 
must be set to that language.

  Setting the Central IMT Language
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The Central IMT uses menus, lists, and tabs to sort and display information. Depending on 
the access levels assigned to your User ID, some of  the menus, lists, and tabs may, or may 
not, be available.

This section provides an overview of  the Central IMT’s graphical user interface.

  Menus

There are fi ve menu items in the Central IMT: File, Permissions, Groups, Tests, and Help. 
The items in each menu are briefl y explained in the tables below.

 File Menu
Print Instrument Options Report Prints an Instrument Option Report. This 

report states the current options for each 
instrument.

Print Report by Permissions Prints a Permission Membership Report. 
This report lists all instruments and roles 
and the users assigned to each.

Print Report By Users Prints a User Permission Report. This 
report lists all users and the roles and 
permissions assigned to each one.

Print Test Defi nitions Report Prints a Test Defi nitions Report. This 
report lists all of  the defi ned tests with their 
parameters.

Language Sets the Central IMT language. To operate 
entirely in the selected language, the 
operating system language must be set to 
the selected language as well.

Set Role Server Lets you enter the Domain and Role Server 
names. This should only be accessed when 
setting up the Service PC or if  a new Role 
Server will be used.

Set Alt Domain Lets you specify an Alternate Domain from 
which to receive user information. If  an 
alternate domain is set then all users listed 
in the Central IMT come from that domain, 
not the primary domain.

Exit Saves changes and closes the Central IMT.

   Graphical User Interface
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 Permissions Menu
Add Instrument Lets you add an instrument name to the 

Central IMT. Each instrument name must 
be unique.

Delete Instrument Removes an instrument.
Refresh Refreshes the user and test lists. While the 

lists are set to update automatically, this 
setting may be used if  users and tests you 
expect to see in the list are not present.

 

 Groups Menu
The Groups menu list becomes available when you select the Instrument Groups tab (Figure 
2).

Add Group Lets you create a new instrument group. 
Once a new group has been added, Rename 
Group and Delete Group menu items 
become active.

Rename Group Lets you rename an existing instrument 
group.

Delete Group Removes a group

  Figure 2: Central IMT Groups Menu and Instrument Groups Tab

 Tests Menu
Edit/View Test Displays the Test Defi nition Editor (TDE).
PSI, mbar, kPa Lets you set the TDE pressure units.
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Help Menu
About Displays the Central IMT version number.
Paths Displays path information for the Default 

Domain, Users, Role Server, Role Server 
data, and Tests

  Lists and  Tabs

The following tables describe the functions and information available in the lists and tabs of  
the Central IMT.

Users List
The Users list (Figure 3) is displayed 
on the left side of  the Central IMT, 
and includes all of  the domain users, 
which are provided by the Domain 
Controller. 

The Users list has a search function 
that allows users to be found by name. 
Click on the Users list and press 
Control-F on your keyboard to open 
the search box (Figure 10). You can 
search on part or all of  a user’s name.

 Figure 3: Users List

 Roles Tab
The Roles tab (Figure 4) is used to 
assign users to roles. 

Selecting one of  the roles from the 
drop-down list shows the users who 
are assigned to that role. Permissions 
for each role are pre-confi gured.  

For more information, see “Roles.”

 Figure 4: Roles Tab
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 Instruments Tab
The Instruments tab (Figure 5) 
is used to assign users and tests 
to instruments, and to confi gure 
report transfer, remote backup, and 
electronic signature options. 

Selecting one of  the instruments 
from the drop-down list shows 
the users that are assigned to the 
instrument and allows access to the 
Options, Tests, and Setup tabs.

 Figure 5: Instruments Tab

 Instrument Groups Tab
The Instrument Groups tab (Figure 
6) is used to assign instruments to 
logical groups, and to confi gure report 
transfer, remote backup, and electronic 
signature options for those groups. 
Selecting one of  the groups from the 
drop-down list shows the users that 
are assigned to that group and allows 
access to the Options, Instruments, 
Tests, and Setup tabs. 

The Instruments tab associated with 
the Instrument Groups tab displays 
a list of  all of  the instruments that 
have been added to the Central IMT. 
Instruments with check marks are part 
of  the selected instrument group.

 Figure 6: Instrument Groups Tab
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 Options Tab
The Options tab becomes available when you select an instrument or instrument group. 
It contains the report transfer, backup, and electronic signature options. The table below 
describes the functionality of  each option. 
Reports: Path Displays the fi le location selected for 

transferring reports.
Reports: Style Allows selection of  PDF, XML or both 

formats for transferred reports.
Reports: Delete On Successful Transfer Sets the instrument to delete tests after a 

successful transfer. (See “Selecting Report 
Transfer Options.”)

Backup: Path Displays the fi le location selected for 
backups

Backup: Style Lets you choose a backup style. The options 
are Current, Full, and Audit. (See “Selecting 
Remote Backup Options.”)

Signature Lines Use the scroll box to set the number of  
required electronic signatures. Use the check 
box to require a supervisor signature. (See 
“Selecting Electronic Signature Options.”)

 Tests Tab
The Tests tab (Figure 7) displays a list of  all 
of  the tests that have been created using the 
Test Defi nition Editor. 

Tests with check marks are available on the 
selected instrument or instrument group.

 Figure 7: Tests Tab
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  Saving Changes

 Setup Tab
The Setup tab (Figure 8) displays a list of  
all of  the fi elds available for the Instrument 
Options Report for a selected instrument or 
instrument group. 

The Comment Required checkbox sets the 
Comment fi eld on an instrument’s Test 
Parameters screen as required or optional. A 
check mark in the box indicates a comment 
is required before a test can be run.

Click the Select All button to select all 
Report Fields in the list.

 Figure 8: Setup Tab

Some changes made in the Central IMT are effective immediately upon their execution (such 
as assigning a user to a role). Other changes, such as updating a fi lter test defi nition or select-
ing a report style, are applied after closing the Central IMT. To ensure that all new confi gura-
tions are applied, close the Central IMT after making changes. If  you make a mistake when 
confi guring an option within the Central IMT, it is best to correct it during the same session. 
If  you already closed the Central IMT, then restart the Central IMT, change the incorrect 
setting, and close it again.

When you use the Central IMT to make changes to the instrument settings, this updates the 
Role Server. The instrument will download those updates the next time a domain user logs 
on, provided that the instrument is connected to the network.

Note: The Service PC must be connected to the Role Server for the Central IMT 
to operate properly. Also, the Role Server must be available on the domain 
when the instrument attempts to download the changes. Otherwise, the 
instrument will continue to operate with the previous settings.
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Chapter 4
Using the Central IMT

 Introduction
Using the Central IMT, the Instrument Administrator can update many of  the settings on 
the instruments from a central location.

Important:  While settings listed in this section can be adjusted via the Central IMT, 
some settings will need to be set on the instrument(s). See the Integritest 
4 Automatic Filter Integrity Test Instrument XIT4S0001 and XIT4N0001 
Operators Manual for instructions.

The Central IMT can be used to manage user access to instruments across the network. 
Users should be assigned roles and instruments. Figure 9 shows the Central IMT when 
limited to user management.

 Figure 9: Central IMT User Management

  Managing Users 
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 Roles
Roles are used in the Central IMT to organize users into groups that have the same 
permissions. This eliminates the need to maintain individual permission levels for each user. 
The Central IMT provides three roles: Service, Supervisor, and Operator. A user can be 
assigned to multiple roles.

Note:  There are additional roles available on the instruments that are not 
available on the Central IMT. For a detailed description of  all roles, refer 
to the Integritest 4 Automatic Filter Integrity Test Instrument XIT4S0001 and 
XIT4N0001 Operators Manual. 

Central IMT roles appear in the drop-down menu in the Roles tab (Figure 4). 

Note:  The Operator role is the default; until you assign a user a role, he or she is 
an Operator. 

    Assigning Users to Roles
Follow these steps to assign a user to a role:

1. Launch the Central IMT and select the role from the drop-down list on the 
Roles tab (Figure 4).

2. Select the user in the Users list and click  . 

Note:  This is not necessary for the Operator role because all users default to the 
Operator role.

   Removing Users from Roles

1. Launch the Central IMT and select the role from the drop-down list on the 
Roles tab (Figure 4). 

2. Select the user from the list of  users assigned to that role and click  .
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   Assigning Users to Instruments

Use the Central IMT to assign users to instruments. Once assigned to instrument(s), a user 
will be able to perform all of  the functions on the instrument(s) allowed by the role(s) set for 
the user.

Follow these steps to assign a user to an instrument:

1. Select the instrument from the drop-down list in the Instruments tab 
(Figure 5).

2.  Select the user in the Users list and click  . To assign a user to all of  the 
listed instruments, select All from the drop-down list and follow the same 
procedure. 

Users can also be assigned to instrument groups, as follows:

1.  Select the group from the drop-down list on the Instrument Groups tab.

2.  Select the user in the Users list and click  . A user assigned to an 
instrument group is able to use all of  the instruments in that group

   Removing Users from Instruments

To remove a user from an instrument or instrument group:

1.  Select the instrument or group from the drop-down list.

2. Select the user to be removed from the list of  users assigned to that 
instrument or group and click   to remove the user from the instrument.

 Searching for Users

The Users list within the Central IMT has a search function that lets you search for users by 
name.

1. In the Central IMT, click on any name in the Users list and press Control-F 
to open the Find box (Figure 10).

 
  Figure 10: Find User

2. Enter all or part of  a user’s name in the Find what fi eld and press Enter or 
click the Find Next button.
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Use the Central IMT to manage instrument settings. Figure 11 shows the Central IMT when 
limited to instrument management.

 Figure 11: Instrument Management Options

Note:  The Options tab shown in Figure 11 is used to configure the instrument(s) 
report transfer, remote backup, and electronic signature options. For more 
information, see “Setting the Central Repository and Backup Location 
Paths” and “Selecting Electronic Signature Options.”

     Adding and Deleting Instruments

To add an instrument to the Central IMT, do the following:

1. Access the Central IMT and select Add Instrument from the Permissions 
menu. This opens the Add Instrument box (Figure 12).

 
  Figure 12: Add Instrument Box

 Managing Instruments
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2. Enter the network name of  the instrument and click OK to add the 
instrument to the Central IMT. 

To delete an instrument from the Central IMT, do the following:

1. Access the Central IMT and select the instrument from the Instruments tab.

2. Select Delete Instrument from the Permissions menu.

3. Click Yes to confi rm that you want to delete the instrument from the Central 
IMT.

Note: The “All” entry cannot be deleted from the list of  instruments.

Working with Instrument Groups

Instruments that will have the same configuration settings can be assigned into groups. This 
eliminates the need to configure each instrument independently. When an instrument is part 
of  a group, its options cannot be changed individually.

   Creating Instrument Groups
To create a new instrument group in the Central IMT, do the following:

1. Select the Instrument Group tab and select Add Group from the Groups 
menu. This opens the Group Management box (Figure 13).

2.  Enter the desired group name and click OK to save the new group.

 
  Figure 13: Group Management Box

Note:  When a group is first created, it does not contain any instruments. Follow 
the steps in “ Adding Instruments to Groups” to add instruments to the 
group.

  Adding Instruments to Groups
To add instruments to a group in the Central IMT, do the following:

1.  Select the group from the drop-down list on the Instrument Groups tab 
(Figure 14).
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  Figure 14: Instruments in Instrument Group

2. In the Instruments tab, select the checkbox beside each instrument you 
want to assign to the group. 

Note:  An instrument can only belong to one instrument group.

 When the next domain login occurs, the group settings will be downloaded from 
 the Role Server.

Note:  If  you want to configure the group’s report transfer, remote backup, and 
electronic signature options, refer to “Setting the Central Repository and 
Backup Location Paths” and “Selecting Electronic Signature Options” for 
instructions.  

  Renaming Instrument Groups
To rename an instrument group in the Central IMT, do the following:

1. Select the group that you want to edit from the Instrument Groups tab.

2. Select Rename Group from the Groups menu. This opens the Group 
Management box (Figure 13).

3. Enter the new group name and click OK to save the new name.

  Deleting Instrument Groups
To delete an instrument group, do the following:

1. Select the group from the Instrument Groups tab.

2. Select Delete Group from the Groups menu.

3.  Click Yes to confi rm that you want to delete the instrument group.



  59  

    Setting the Central Repository and Backup Location Paths

The Central Repository and Backup Location must fi rst be mapped to a network drive on 
the Service PC before they can be selected as the repository or backup path. 

Contact your Network Administrator for assistance with mapping network drives.

To set the location of  the Central Repository or Backup Location, do the following:

1. Click   located above the Path fi eld (Figure 15). 

  
  Figure 15: Reports Path

 This opens a window that lets you set the reports path (Figure 16).

 
  Figure 16: Select Path for Reports

2. Select the drive mapped to the Central Repository or Backup Location. If  
required, fi ll in the User Name and Password fi elds to allow access to the 
remote drive.

Note:  Configuring the instrument(s) to transfer reports or send remote backups 
to a local directory or the floppy drive may result in errors and/or eventual 
data loss.

3. Click OK to confi rm the new location. You may close the Central IMT to 
save the changes or proceed to “Selecting Report Transfer Options” for 
instructions on setting the other report options.
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    Canceling Report Transfer and Remote Backup

If  you want to cancel report transfer and/or remote backup:

1. Click the   located above the Path fi eld.

2. In the Select Path for Reports window (Figure 16), click the Clear Path 
button. This will clear all text from the Path fi eld(s). 

3. Close the Central IMT. At the next connected login, the instrument(s) will 
not send test reports and/or will perform backups to the fl oppy drive.

   Selecting Report Transfer Options

You can use the Central IMT to centrally confi gure report transfer options for instruments. 

If  report transfer options are confi gured using the central IMT, the data for the instruments 
is sent to the Central Repository in a secure report for later retrieval and review once tests 
are completed. 

Note:  This section provides an overview of  configuring remote report transfer 
using the Central IMT. Descriptions of  the report transfer options are 
provided in the Integritest 4N Integrity Test Instrument Network and Administrator 
Manual.

The report transfer options are displayed in the Reports box on the Options tab. The steps 
below describe how to confi gure the report transfer options using the Central IMT:

1. Select the instrument from the Instruments tab or the group from the 
Instrument Groups tab.

2. Select the Options tab.

3. In the Reports box, the Path fi eld contains the path to the Central 
Repository for reports (see “ Setting the Central Repository and Backup 
Location Paths”).

4. There are two report styles available for transferred reports: PDF and XML. 
In the Styles box, select PDF or XML or both by placing a check mark next 
to the desired style(s). 

Note:  For more information about the PDF and XML formats, see the Integritest 
4N Integrity Test Instrument Network and Administrator Manual.

5. If  you want test data removed automatically from the instrument after it 
has been transferred and processed, then place a check mark in the Delete 
on Successful Transfer fi eld. If  you select this option, the test data will be 
removed from the instrument when certain conditions apply.
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Note:  For information about these options, see the Integritest 4N Integrity Test 
Instrument Network and Administrator Manual.

   Selecting Remote Backup Options

Using the Central IMT, you can confi gure any number of  instruments to send backup 
data to a specifi ed Backup Location on the network. Once a Backup Location is set, the 
information is automatically backed up there once a week.

This section describes the remote backup options available through the Central IMT. 
Instructions for performing a backup on an instrument are found in the Integritest 4 Automatic 
Filter Integrity Test Instrument XIT4S0001 and XIT4N0001 Operators Manual. For information 
about the types of  fi les saved and created during backups, see the Integritest 4N Integrity Test 
Instrument Network and Administrator Manual.

The remote backup options are displayed in the Backup box on the Options tab. Follow the 
steps below to confi gure the remote backup options.

1. Select the instrument from the Instruments tab or the group from the 
Instrument Groups tab.

2. Select the Options tab.

3. In the Backup box, the Path fi eld contains the path to the Backup Location 
on the network (see “Setting the Central Repository and Backup Location 
Paths”). If  you leave the Path fi eld empty, this will cause the instrument to 
send backups to its fl oppy drive, and the user performing the backup must 
select a backup style.

4. The Style options are only available if  you entered a path in the Path fi eld. In 
the Styles box, select the Current, Full, or Audit backup style. 

   Selecting Electronic Signature Options

You can use the Central IMT to confi gure electronic signature options for instruments and 
instrument groups. 

This section describes the electronic signature options available through the Central IMT. 
For more information about electronic signatures, see the Integritest 4 Automatic Filter Integrity 
Test Instrument XIT4S0001 and XIT4N0001 Operators Manual and the Integritest 4N Integrity Test 
Instrument Network and Administrator Manual.

The electronic signature options are displayed in the Signature Lines box on the Options tab. 
Follow the steps below to confi gure the electronic signature options using the Central IMT.

1. Select the instrument from the Instruments tab or the group from the 
Instrument Groups tab.

2. Select the Options tab.
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3. In the Signature Lines box, select zero, one, or two signatures. 

If  0 is selected, the check box for Requires Supervisor will be grayed 
out on screen, and no signatures will be necessary for test report 
transfer.

If  1 is selected, the instrument will require one user to enter a User 
ID, password and reason for signing. Once this is done, the test report 
is considered complete, and the report will be transferred if  a valid 
network connection is available.

If  2 is selected, one user must enter the required information. Once 
that is completed, a second signature box becomes available, and 
a second user must enter their information. A different user must 
provide the second signature, with a different User ID and password.

4. Check the Requires Supervisor box to require that a supervisor signs the 
report. This option is only enabled for two signatures and will be grayed out 
if  less than two are selected.

•

•

•
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  Creating and Editing Tests

  The Test Defi nition Editor
You use the Test Defi nition Editor (TDE) to create new test programs and specifi cations, 
and to view, edit, or delete existing test programs and specifi cations. Figure 17 shows the 
TDE.

 Figure 17: Test Defi nition Editor (TDE)

To access the TDE, select Edit/View Tests from the Central IMT’s Tests menu.

Note:  An on-screen keyboard is part of  the TDE. Data may be entered with the 
on-screen keyboard using a mouse if  a normal keyboard is not present.

For step-by-step procedures on using the TDE, refer to Integritest 4 Automatic Filter Integrity 
Test Instrument XIT4S0001 and XIT4N0001 Operators Manual. 

   Managing Tests



  64

  Selecting  Pressure Units
From the Central IMT, you can set the pressure units that will be used in the TDE. There 
are three selectable units: PSI, mbar, and kPa.  The default pressure unit is PSI.

To change the default pressure unit used by the TDE, select the option from the Central 
IMT Tests menu.

Important:

PSI or mbar are the recommended units because filter specifications 
are normally provided in either of  those units.

It is recommended that the TDE and the instruments use the same 
pressure units. If  the TDE pressure units are different from the 
instruments’ units, the test input data (upstream volume, minimum 
bubble point, etc.) will be converted at the instrument.

For additional information, refer to the Integritest 4 Automatic Filter 
Integrity Test Instrument XIT4S0001 and XIT4N0001 Operators Manual. 

    Assigning Tests to Instruments

Use the Central IMT to assign tests to instruments or instrument groups. Figure 18 shows 
the Central IMT when limited to test management.

 Figure 18: Test Management

You create tests using the Test Defi nition Editor (TDE). (See “The Test Defi nition Editor.”) 
Once a test is created and saved, you can assign it to an instrument or instrument group by 
using the Tests tab (Figure 18). Follow the steps below:

1. Select the instrument or group from the Instruments or Instrument 
Groups tab and then click the Tests tab. The Tests tab lists all available tests 
in the Central IMT.

2. Place a check mark next to tests that should be available on that instrument 
or group, and remove any check marks next to tests that should be 
unavailable.

•

•

•
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3. Close the Central IMT to save the changes. At the next connected login, the 
instrument will contain all of  the selected tests.

Important:

Although tests can be administered via the local IMT on the 
instrument, this is NOT recommended while in domain mode.

If  the instrument(s) are set to merge tests, additional tests beyond 
those marked in the Central IMT may be available on the instrument. 

Test specifications are created, modified, and deleted using the TDE. 

See “Managing Tests” and the Integritest 4 Automatic Filter Integrity Test 
Instrument XIT4S0001 and XIT4N0001 Operators Manual for more 
information.

In addition to confi guring report options for networked instruments using the Central IMT, 
you can also print the administrative reports described in the table below.

Report Description

Instrument Option Report This report states the current options for each 
instrument.

Permission Membership Report This report lists all instruments and roles and the 
users assigned to each.

User Permissions Report This report lists all users and roles.
Test Defi nitions Report This report lists all of  the defi ned tests with their 

parameters.

Note:  For information about configuring report options for the instruments using 
the Central IMT, see “Selecting Report Transfer Options.” 

  Printing the Reports

Do the following to print a report:

1. Depending on the type of  report you want to print, select Print Instrument 
Options Report, Print Report by Permissions, or Print Report by Users from 
the Central IMT’s File menu.

2. In the Windows Print box, ensure that the printer you want is selected and/
or adjust the options as needed.

3. Click OK. The report will be printed to the selected printer in accordance 
with the options you selected.

•

•

•

•

 Reports
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Backup Saves test specifi cations and archives. The type 
of  instrument data saved is set by the Instrument 
Administrator.

Backup Location The network location to which the instrument(s) send 
backups.

Central IMT Central Instrument Management Tool. See the 
“Instrument Management Tool” glossary item below.

Central Repository The network location to which the instrument(s) send 
test reports.

Domain Controller The Domain Controller is used to create and manage 
users. This computer provides all the required User ID, 
security, and password verifi cation information when the 
instrument(s) are in Domain mode.

Domain Mode Operation mode of  instruments that are part of  a 
domain. User information and security comes from 
the Domain Controller, and all of  the network features 
are available. The instrument(s) are updated with 
confi guration changes by the Role Server.

ID Mapper The ID Mapper Tool is a utility that lets organizations 
map their required or preferred group names, user 
names, and passwords to the default group names, user 
names, and passwords used by the software.

Instrument 
Administrator

The person responsible for confi guration and 
management of  the instrument(s); defi nes users, 
instrument groups, and where and how instruments 
are to be used. Confi gures access, roles, reporting 
defaults, signature requirements, and other details for 
each instrument or instrument group. Depending 
on the organization, multiple people can function as 
Instrument Administrators, and a single Instrument 
Administrator may control many instruments.
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Instrument Group A set of  instruments that have the same confi guration 
of  users, roles, and test and fi lter defi nitions. When 
an instrument group is created in the Central IMT, 
any changes made to the group are applied to each 
instrument in that group.

Instrument 
Management Tool 
(IMT)

A tool used by the Instrument Administrator to 
confi gure user access, permissions, and usage of  
instruments, tests and fi lters. When instruments are 
in Domain mode, the Central IMT runs on a Service 
PC. When instruments are in Workstation mode, the 
local IMT on the instrument is used to manage that 
instrument only.

Integrity Test An integrity test is a test used to determine whether or 
not a fi lter has a defect capable of  passing particles that 
should be retained. Tests performed by the Integritest 
4N instrument(s) are non-destructive and non-
contaminating.

MIS (Management 
Information 
Systems)

A general term for the computer systems in an 
enterprise that provide information about its business 
operations. The term is often used to refer to the 
departments or people who manage these systems.

Network 
Administrator

Has administrator-level access to the network and 
is responsible for adding new computer, users, and 
maintaining network security. For instruments in 
Domain mode, the Network Administrator confi gures 
the Role Server and Service PC and administers user 
accounts and passwords. 

Networked 
Workstation Mode 

The instrument is connected to a network, but is 
not part of  a domain. Instrument confi guration is 
performed using the local IMT. The instrument can be 
set to transfer fi lter tests, perform remote backups, and 
require electronic signatures.

PDF Portable Document Format, a multi-platform fi le 
format developed by Adobe® Systems. A PDF fi le 
captures document text, images, and the formatting of  
documents from a variety of  applications. Viewing a 
PDF fi le requires Acrobat® Reader®.

Restore Returns data saved during a backup to the instrument(s). 
This is not available for all types of  backups.
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Role Server The Role Server stores information on users, 
instruments, instrument groups and instrument 
confi gurable parameters. The Role Server also stores 
test specifi cations and all confi gured parameters that are 
programmed using the Central IMT. In Domain mode, 
this function is provided by a computer on the network. 
In Workstation mode, all Role Server operations are 
performed by the instrument.

Service PC This computer allows access to the Central IMT 
for instruments in Domain mode. Filter and test 
specifi cations, instruments, and roles are confi gured 
from the Service PC and stored in the Role Server.

Test Defi nition 
Editor (TDE)

Allows a user to create and edit test specifi cations. The 
TDE is accessed through the Central IMT’s Tests menu.

XML Extensible Markup Language, is a subset of   SGML 
(Standard General Markup Language) for Web page 
use. XML is used to defi ne documents with a standard 
format that can be read by any XML-compatible 
application.
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Appendix B 
 Error Messages

This table lists some of  the error messages that may appear while using the Central IMT.

Note:  This is not an exhaustive list of  all the possible error messages. The specific 
error messages generated while using the Central IMT depend on the 
configuration of  the instrument and the network to which it is connected. 
This table lists the most common error messages.

Scope Message Cause

Service PC at IMT 
launch

Windows cannot access the 
specifi ed device, path or 
fi le. You may not have the 
appropriate permissions to 
access the item.

Attempting to launch the Central 
IMT on the Service PC without 
the correct access level.

Service PC and 
instrument

Role Server Unavailable Role Server is not accessible 
from Central IMT. Check 
network connections and Role 
Server settings.

Select Path windows The user name or password 
has not been specifi ed. This 
may make it unable to share 
this directory.

No user name or password 
specifi ed to access the Central 
Repository or Backup Location.

Adding new group Group name is too long. 
Maximum length is 15 
characters.

Entered group name is too long.

Adding new group Group name already exists. Entered group name already 
exists.

Adding new 
instrument

Instrument name is too 
long. Maximum length is 15 
characters.

Entered instrument name is too 
long.

Adding new 
instrument

Instrument name already 
exists.

Entered instrument name already 
exists. 
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 Technical Assistance
For more information, contact the Millipore offi ce nearest you. In the U.S., call 1-800-MILLIPORE 
(1-800-645-5476). Outside the U.S., see your Millipore catalogue for the phone number of  the offi ce 
nearest you or go to our web site at www.millipore.com for up-to-date worldwide contact information. 
You can also visit the tech service page on our web site at www.millipore.com.
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